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SOX Check Approval 2018-2025 is described in several documents, with each one targeted at a 
different user. All guides describe the Standard and Enterprise versions of the product. 

• SOX Extended Payment Batch List User Guide is for users of Sage 300 who prepare 
payment batches and submit them for approval. 

• SOX Check Approval Console User Guide is for key users who will perform a 1, 2 or 
3-step approval. These users may not be familiar with Sage 300. 

• SOX Check Approval Web Screens User Guide is for users of the web-based 
versions of Sage 300 who approve A/P payment batches or submit them for approval. 

• SOX Check Approval Audit Report User Guide is for users who oversee the A/P 
check process. The report provides an audit trail for the approval of Sage 300 checks. 

• SOX Check Approval Setup Guide is a document written for system administrators 
who will install the software, set up databases, and configure the solution.  

• SOX Check Approval Update Guide provides important information for system 
administrators who are updating an installation from a prior version of Check Approval. 

Note: SOX Check Approval keeps status and audit information for multiple Sage 300 databases 
in an Approval Database. The Approval Database is not a Sage 300 database. 

SOX Check Approval Setup Steps 

This checklist describes the installation and setup steps for SOX Check Approval. Complete 
instructions for setting up SOX Check Approval are provided in the rest of this document.  
 

 Install Check Approval Software using the appropriate setup program provided. 

• You must install Check Approval on all machines where Sage 300 is installed. 

 Create a SQL Server database using SQL Server Management Studio. This is not a Sage 300 

company database. It stores approval data and logs from multiple companies. 

• You require one (and only one) approval database for Check Approval. 

 Run Data Activation for "SOX Check Approval" in all Sage 300 companies that will use SOX 
Check Approval. SOX Check Approval will appear on the Sage Desktop. 

• You need to activate Check Approval for each company using Check Approval. 

 Select “SOX Check Approval” on the Sage Desktop and open the Check Approval Setup 

program. You must enter the license information the first time you choose Check Approval Setup. 

 Enter the connection information for the SQL Server database in the fields at the top of the 
System tab. Click on the Test Connection button to verify the connection. 

 On the Database tab, make sure the <All> Tables choice is selected and click on the Create 

button. This will create all tables in the database. 

 Select program options on the Options tab. (If upgrading from older versions of Check Approval, 
uninstall the Desktop Control on each computer where Sage 300 is installed.) 

 On the Company tab, select the Sage 300 users who approve checks. Enter and test their Sage 

passwords. An administrator may do this for executives who do not use Sage 300. 

 If you use the Enterprise version of SOX Check Approval, on the Banks tab, add the banks 
for which you are approving checks, select the check approval workflow for each bank, the 
number of check approval levels, and the Sage 300 users who approve checks at each level. 
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If you just updated SOX Check Approval from a prior version,  
the database may also need to be “converted” 

Note:  If have installed a new version of SOX Check Approval, and these messages appear 
when you open the SOX Check Approval Console program or when you open the A/P 
Payment Batch program or the SOX Check Approval Audit Report, you will also need to 
update the Check Approval database to the newest version.  

             

Go to I just updated SOX Check Approval and got a message that the database needs to be 
“created or converted.” This FAQ provides full update instructions. 

Step 1 – Install SOX Check Approval Software  

This guide takes you through the process of installing SOX Check Approval software on Sage 
300 computers and setting up TaiRox SOX Check Approval. 

NOTE: This guide describes the Standard and Enterprise versions of  
SOX Check Approval 2018-2025 

If you have version 2017 or earlier of Sage 300, you should install SOX Check Approval for 
Sage 300 2012-2017. 

If you try to Activate SOX Check Approval 2018-2025 with Sage 300 2012-2017, it will display 
an error stating that SOX Check Approval 2018-2025 requires System Manager 6.5A or later. 

SOX Check Approval installation files 

Note: The installation files for the Standard and Enterprise versions of SOX Check Approval are 
the same. The different versions are activated by different license files. 

The installation files for SOX Check Approval 2018-2025 are as follows: 

Installation Files for SOX Check Approval Setup program & Check Approval Console 

• Desktop-2018-2025.msi 

Program for installing Check Approval software on Sage 300 computers. 

You must install this program on each computer where Sage 300 is physically installed.  

For example, if you have one or more RDP servers and use workstation setup, make 
sure that you install the SOX Check Approval program on all RDP servers. (After 
installing, you must also run RegAcc.exe on each workstation that runs Sage 300 from a 
server, or run Workstation Setup with “repair”.) 

• Console-2018-2025.msi 

Program for installing the SOX Check Approval Console on approvers’ computers. 

o You must install the Console on all computers where Sage 300 is physically installed 
and on all approvers’ computers where you want to run the Check Approval Console. 



SOX Check Approval Setup  Step 1 – Install SOX Check Approval Software 

SOX Check Approval for Sage 300 3 Setup Guide 

o You must also install Sage 300 – or run Sage 300 workstation setup – on all 
approvers’ computers where you want to run the Check Approval Console. 

Installation ZIP Files for SOX Check Approval Web Screens 

The SOX Check Approval Web Screens “Download” zip file contains 6 installation files that 
support 3 different versions of Sage 300.  

You must use the installation files that match your version of Sage 300. 

• Sage 300 version 2023_0               for the original release of Sage 300 2023 
o TCSAWeb_2023_0_setup.msi    -- installs Web Screens 
o TaiRox.SCA.Customization_2023_0.zip -- installs A/P Batch List button 

• Sage 300 version 2022_2               for Sage 300 2022.2 and higher (e.g. PU2, PU3) 
o TCSAWeb_2022_2_setup.msi    -- installs Web Screens 
o TaiRox.SCA.Customization_2022_2.zip -- installs A/P Batch List button 

• Sage 300 version 2021_2               for Sage 300 2021.2 and higher (e.g. PU5, PU6) 
o TCSAWeb_2021_2_setup.msi    -- installs Web Screens 
o TaiRox.SCA.Customization_2021_2.zip -- installs A/P Batch List button 

Note regarding the Web version of SOX Check Approval 

Do not install the SOX Check Approval Web Screens unless you use Sage 300 Web Screens  
Note: Web screen installation files are Sage 300-version-specific. You must install a web 
version that matches the version of Sage 300. TaiRox has a Web Check Approval Console 
for version 2021 of Sage 300 (PU2 and higher), 2022 (PU2 and higher), and 2023. 

As you complete the steps for setting up Check Approval, keep the following points in mind. 

• You require one (and only one) approval database for Check Approval. You create this 
database in Step 2. 

• You must install the Check Approval Setup program using Desktop-2018-2025.msi on 
each computer where Sage 300 is physically installed. 

It may help to sketch out your Sage 300 and Check Approval installation.  

• You must activate SOX Check Approval for each company that uses SOX Check 
Approval. You activate Check Approval in Step 3. 

• You must install the Check Approval Console (Console-2018-2025.msi) on all computers 
where Sage 300 is physically installed – and any other computer where you want to run 
the Check Approval Console. You must also install Sage 300 on check approvers’ 
computers or run Workstation Setup. 

• After installing, you must run RegAcc.exe on each workstation that runs Sage 300 from 
a server (or run Workstation Setup with “repair”). 

• If you use Sage 300 Web Screens and want to run SOX Check Approval in a browser: 

o You must install the Web Screens for SOX Check Approval on all computers where 
Sage 300 is physically installed. 

Run “iisreset” after uninstalling a prior version of SOX Check Approval Web Screens, 
and clear your browser’s cache of temporary Internet files. 

Run “iisreset” and clear your browser’s cache after installing the new version of SOX 
Check Approval Web Screens. 



SOX Check Approval Setup  Step 2 – Create SQL Server Database – First Company Only 

SOX Check Approval for Sage 300 4 Setup Guide 

o You must install the SCA customization package for A/P on all computers where 
Sage 300 is physically installed and assign it to all companies that use SOX Check 
Approval. See Installing Sage 300 Web Screen Customizations for more information.  

Run “iisreset” after disabling and deleting a prior version of the customization 
package on each computer, and then install and assign the new customization 
package to each Sage 300 company and run “iisreset” on each web server. 

Step 2 – Create SQL Server Database – First Company Only 

Important Note:  If you are going to approve checks for more than one company, you 
create the Approval Database when setting up the first company. The Approval Database 
stores checks from multiple companies.  

First Company Only 

Prior to setting up and using Check Approval with Sage 300, you must create a SQL Server 
“approval” database using SQL Server management tools. You can use any name for the 
database – for example, “APPROVAL”. 

Collation – Latin1_General_BIN 
Recovery Model – Simple 

The database name, connection information and passwords are kept in an INI file, which will be 
created by the Check Approval Setup program in Step 4. 

Do not create another “approval” database if you previously created one to set up Check 
Approval with another company using the same Sage 300 server. 

Step 3 – Activate SOX Check Approval – All Companies 

You must activate SOX Check Approval just like any core Sage 300 application.  

• If you install SOX Check Approval 2018-2025 and try to Activate it on a version of Sage 
300 that’s earlier than 2018, Sage 300 will display an error stating that SOX Check 
Approval 2018-2025 requires System Manager 6.5A or later. 

You must activate the program in all companies for which you want to control check printing. 
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Step 4 – Enter License Information and Create Database Tables  
 – First Company Only 

After activating SOX Check Approval for a company, the SOX Check Approval module will 
appear in the Sage 300 menu structure, with two icons, Check Approval Setup and Check 
Approval Audit Report, as shown below.  

 

Enter the license information  

Double-click the Check Approval Setup icon. If this is the first time that you open the program, 
the following form will appear for you to enter SOX Check Approval license information. 

 

• Check the company name on the form. It must match the name used to generate the 
license. 

• Enter/paste the license code into the License field, and click OK. 

The program will then display the Check Approval Setup program. 

Note:  TaiRox Software provides two version of SOX Check Approval 2018-2025 – the 
Standard version and the Enterprise version. Note that the Enterprise version includes an 
additional “Banks” tab for specifying workflows on a per bank basis: This guide shows the 
Banks tab in most screen shots. 
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Standard version tabs: 

 

Enterprise version tabs: 

 

To connect to the Check Approval database and create database tables  

When the Check Approval Setup program appears: 

• Select the System tab. (This is the first tab.) 

 

Enter connection information for the SQL Server Approval database that you created for 
SOX Check Approval, and click the Test Connection button.  

o For Server, enter the name\instance of the SQL server with the Check Approval 
database. 

o The User is the SQL Server account for accessing the Check Approval database. 

• If the connection is successful, select the Database tab to create the database 
tables. 

Make sure <All> tables are selected, and then click the Create button.  

 

Once you click Create, the Check Approval database will be set up and ready for use. 

When you have successfully created database tables, go to Step 5 – Specify the 
Approval Database User and Email Server Setting on the System Tab. 

Viewing the .INI file for SOX Check Approval 

You can click the Open INI File button at the bottom of the screen to display the Check Approval 
licensing information and the connection and setup information that you just saved.  

All password information is encrypted in the .ini file (shown below). 
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The INI file is kept in the Sage 300 shared folder, as it must be accessed by all users. 

Upgrade Notes – Convert Button:  

Some upgrades to the Check Approval module may also require a database update of the 
approval database. For example, you must update the database after the April 2025 update. 

Press the Convert button to perform a database update, if necessary.  

• If the database requires an update, the program will display an error message stating 
that the database must be upgraded. 

• If you click the button now, the program will display a message stating that the database 
is at the current level.  

Note that if you are updating to SOX Check Approval 2018-2025 from an earlier version of SOX 
Check Approval, you may have to run Convert to update the database to version 4.0. 

Additional Notes – Loading table data on the Database Tab 

The Database tab has two uses: 

• It lets an administrative user create the tables in the SQL Server Check Approval 
database. You will do this only once! 

• It also lets you display the data in the Check Approval database tables. This feature can 
help you diagnose problems with the program or processes. You can also drop and 
create individual tables if this becomes necessary for data repair.  

To view a table, select the table you want from the Tables dropdown, and then click the 
Load button. (The table will be empty in a new database.) 

 

Step 5 – Specify the Approval Database User and Email Server  
           Settings 

The System tab requires you to: 

• Specify a single Sage 300 User – typically, the ADMIN user – that will be used to 
authenticate check approvers when they log in to the Check Approval Console. 
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• Specify the settings for the email server that will send notifications to check approvers. 

• Identity your document management program if you use one that is supported by SOX 
Check Approval. 

Specify the Approval database user  

• Select the System tab. (This is the first tab.) 

 

Select the Sage 300 User, enter the user’s password, and test the connection to Sage 
You must select the Sage 300 User account that will be used by the Check Approval 
Console to sign on to Sage 300, authenticate check approvers, and perform Check Approval 
processes.  

Typically, you will use the ADMIN user ID for this. 

• Note:  If you do NOT use the ADMIN ID, the Sage 300 User ID entered here must have 
Payment Batch Entry rights.  

This user account is required to connect to Sage 300 and perform the required 
operations when batches are approved. 

See Rights Required for the Approval Console’s Sage 300 User Account. 

• The Sage 300 User password is encrypted and stored with the connection information. 

• Click the Test Connection button after entering the ADMIN ID and password. 

Specify the settings for your email server 

Enter the settings for your email server.  

• Enter the settings for your email server. These Email Server settings apply to all 
companies using SOX Check Approval. 

• You can use any SMTP server accessible from the program server with credentials as 
you would set them up in an email client such as Outlook.  
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Turn on email logging to diagnose problems 

Turn logging on if you have email issues. The “Enable Email Logging” checkbox creates a 
technical email log that documents all of the handshaking involved in communicating with an 
SMTP server. This feature helps you diagnose setup issues, as well as ones that arise due to 
email providers’ changes.  

You can find the email log file in: 

>Sage300\SharedData\Company\TaiRox SOX Check Approval \Logs 

Send test email  

The Send Test Email button lets you check your settings.  

Click the Send Test Email button, then provide a Mail To address for the test. 

 

If the send test email fails, a message like the following one will appear. See the log file 
at “C:\Users\<username>\AppData\Local\Temp\SOX Check Approval.log” for details. 

 

Note regarding “Enable SSL” if unsupported by the SMTP server  

If you select the “Enable SSL” checkbox, the program will first try to send a test email 
securely. If it does not succeed, it will try to send a test email insecurely. The program will 
display an error message if the secure test fails, but the insecure test is successful. 

 

If this message appears, it means that Your SMTP server does not support current email 
communication styles on the port provided. (The "Enable SSL" checkbox has different 
meanings for different email sending mechanisms, particularly older ones.) 

• You should uncheck “Enable SSL” to send emails without SSL protection. 
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Specify document management settings 

Document Management  
Document Management integration is available for Altec DocLink, Orchid Document 
Management Link, and docSTAR Eclipse, and is controlled by the activation code. (See 
Additional Setup Requirements for Orchid Document Management Link.) 

Note that for docSTAR integration, a URL must be provided by your docSTAR installer and 
entered here. 

Step 6 – Choose Check Approval Options on the Options Tab 

Now that the database has been set up, you can choose Check Approval options.  

You must do this step for each company that will use SOX Check Approval. Check Approval 
supports multiple versions of Sage 300 in different companies at the same time.  

The settings on this tab are per company. 

   

Set Check Approval Status to – controls how checkboxes are defaulted on the Check 
Approval Console when a batch is displayed for the first time: 

• Approved (checked)  

• Not Approved (unchecked)  

• Approved if Less Than or Equal to nnn.  

If you choose “Approved if Less Than or Equal to”, you must also enter a functional currency 
threshold amount. Setting this amount facilitates operations when approval is only required 
for checks above a certain value – while at the same time making the other entries in the 
batch visible to approvers.  
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Allow System Batch created by ‘Create Payment Batch’ to be Changed to Generated 
Sage 300 allows only 1 unposted System batch to be generated company-wide.  

Select this checkbox if you wish to generate multiple batches and submit them for approval 
simultaneously. This will safely change the batch type to be ‘Generated’ rather than 
‘System’. You will be prompted for confirmation when the batch is submitted for approval. 

Put Checks Not Approved in a New Batch 
When final approval has been made, all checks that are not approved are removed from the 
payment batch.  

Select this checkbox if you want the deleted checks to be put into a new batch, facilitating 
re-submission. 

Restrict Vendors in Payment Batch to Vendors whose Bank Matches the Payment 
Batch Bank 
This setting prevents users from adding payments with A/P Payment Entry for vendors 
whose banks do not match the batch bank. 

For example, if the payment batch bank is CCB, and you try to enter a payment in Accounts 
Payable for a vendor that’s assigned to the SEATAC bank code, the following message will 
appear. 

 

A User Can Approve a Batch they Submitted  
Leave this option unchecked if you do not want users to be able to approve batches they 
submitted. 

Submit These Payment Types for Approval  
Check Approval lets you choose which payments types go through the check approval 
process. 

 

If you are upgrading from a version of Check Approval installed prior to Oct 6, 2020, “Check” 
will be the only selected payment type. As of Oct 2020, Cash, Credit Card, and Other 
payment types can also be submitted for approval in the Check Approval Console. 

Note that payment types are associated with payment codes in Accounts Payable.   

Exclude These Payment Types from Approval  
Check Approval lets you exclude batches from the approval process based on the Payment 
Code. 
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Use the Finder in the grid to select payment codes. 

  

Email Notifications 

The Email section on the Options tab provides settings for email notification and email 
recipients. 

  

Note that these Email notification settings are per company.  

The Email Server settings for all companies are on the System tab. 

Email Notification checkbox – Select this box to send emails to approvers and to users 
who submitted batches for approval. 

The program uses the Sage 300 Email 1 addresses stored in Administrative Services > 
Users. 

If you are upgrading from a prior version, make sure that all submitters and approvers have 
email addresses added to their user profiles in Sage 300. Prior versions of SOX Check 
Approval (before October 2022) used distribution lists to inform approvers of new batches.  

Notify Submitter Upon Final Approval – Select this box to send approval notices back to 
the users who submitted batches.  

The program will use the Email 1 email address of the submitter set up in the User window 
in Sage 300. 

Note that “Final Approval” means “completion of the approval process”, so notifications will 
also be sent if the batch is returned to the original submitter. 

Final Approval Distribution List – Enter any other email addresses that you want notified 
when a batch has been approved. The following example shows that an email will also be 
sent to the payables department email when a batch has been approved. 

  

You can enter a list of addresses separated by semicolons. 

Email Subject – Click the Zoom button on the right side of the subject field to view a list of 
variables that you can insert into the Email Subject line. 
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In this example, the program will include the batch number and description in the email 
subject. 

 

Using Windows Authentication with Sage 300 users 

Approver's passwords are not stored by SOX Check Approval. Typically, as executives, they 
may be set up to use Windows authentication to log into Sage 300 – and this mechanism is 
used by the Check Approval Console so as to avoid unnecessary authentication. 

Check Approval Console sign on error messages 

The following error messages may appear when users sign on for the first time to the Check 
Approval Console. 

Invalid input:  The following error message will appear if the ID entered has not been 
added to Sage 300 or if the password entered by the user is incorrect.  

 

If this is the first time signing in, check that the User ID has been added in Sage 300, and 
confirm the password. (You can test the ID by using it to sign on to Sage 300.) 

Signon failed:  This next message can appear if you were assigned a new Sage 300 ID 
that required a password change on the first login, or if the ID password has expired.  

 

If this is the first time the user has signed in, they should sign in to Sage 300 to ensure their 
ID works properly, and then change their password if requested by Sage 
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Step 7 – Choose Check Approval Workflow and Set Up 
Approvers for Company Workflows 

Note:   

    •    The settings on this tab are all per company.  

    •    If you use the Enterprise version, these settings will be in effect for all payment  
    batches that are not for the banks listed on the Banks tab. 

    •    You must choose a workflow and specify approvers for the current company on this  

    tab before you can save Check Approval settings.  

  

Select the Approval Workflow for your company 

SOX Check Approval supports four different approval workflows. You select approval 
workflows on a per company basis, from the following drop-down (at the top of the tab): 

 

• Strict: All checks must be approved at all levels  
This workflow lets you specify up to three levels of check approvers. Choose this 
workflow when the top level of approval must see all checks in all batches. 

• Basic: Checks above level limits must be approved at higher levels after first 
being approved by lower-level approvers 
Like the Strict workflow, this option lets you specify up to three levels of check 
approvers. Choose this workflow when the top levels of approval only want to see 
checks above specified limits, and those checks must first be approved at lower levels. 

When you choose “Basic”, a set of fields will appear below the check approvers to let 
you specify the approval limit for each level. 

 

• Relaxed: Checks above level limits must be approved at higher levels and not 
seen by lower-level approvers 
Like the Strict workflow, this option lets you specify up to three levels of check 
approvers. Choose this workflow when the top levels of approval only want to see 
checks above specified limits, and those checks are not to be approved at lower levels. 

When you choose “Relaxed”, a set of fields will appear below the check approvers to let 
you specify the approval limit for each lower level. 
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• Simplified: Checks must be approved by a number of users 
Choose this workflow when each check requires more than one approver, but there is no 
hierarchy for approvers. 

You will see a warning message if you change the check approval levels: 

  

Warning:  This message applies to you if you are already using SOX Check Approval and 
have batches that are currently in the approval process. To avoid issues, you should 
approve all batches that are currently in progress before changing workflows. 

Select the number of approvers / approval levels  

If you choose the Strict, Basic, or Relaxed workflow, you can have up to 3 levels of 
approval.  

 

If you choose the Simplified workflow, you can require up to 3 check approvers per check.  

 

Select the check approvers at each Level 

You must identify all check approvers at Level-1, level-2 and level-3 if you use the Strict, 
Basic, or Relaxed workflow (and you use 3 levels).  

• You cannot select the same check approvers at multiple levels. If you want multiple 
approvers – in any order – choose the simplified workflow, then identify all acceptable 
approvers. 

• Users cannot be approvers for a batch they submitted unless you select the option “A 
User Can Approve a Batch They Submitted” on the Options tab. 

• Approvers must first be added as Sage 300 users in order to appear on this tab.  

Specify the check limits if using the Basic or Relaxed workflow  

When you choose “Basic” or “Relaxed”, the following set of fields will appear below the 
check approvers to let you specify the approval limit for each lower level. Checks below a 
level limit do not need to be approved at the next level  
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When Changing Levels of Approval and Limits:  You can change the Levels of Check 
Approval and the Approval Limits; however, to avoid issues, you should approve all batches 
that are currently in progress before changing workflows. 

Any batches that are in the approval process will still require the original approval levels – 
which means that, if the number of approvers changes from 3 to 2, the unapproved batches 
will still need a third level of approval.  

Sample Check Approval Settings 

The following screens illustrate each of the four workflow settings:  

 • a 3-level process where each check must be approved by a level-1 approver, a level-2 
approver, and a level-3 approver. 

 • a 3-level “basic” process that requires fewer approvers for smaller check amounts. 

 • a 3-level “relaxed” process where each check is approved at one level by an approver. 

 • a single-level process that allows up to three users to approve in any order. 

Sample Strict settings where all checks must be approved at all levels 

 

Sample Basic settings where checks below limits require fewer approvals 

 

Clarification:  With the above set up: 

• The level 1 approver, Morgan Evans, will see all checks.  

Checks up to and including the level 1 limit only require approval by Morgan Evans. 
Checks over the level 1 limit will be routed to Samantha Long after they are approved by 
Morgan Evans. 

• The level 2 approver, Samantha Long, will see all checks over $1,000.  

Checks up to and including the level 2 limit require approval by Morgan Evans and by 
Samantha Long. Checks over the level 2 limit will continue to the level 3 approver, 
Frederic Winkler, after being approved by Samantha Long. 
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• The level 3 approver, Frederic Winkler, will only see checks above $10,000.  

In other words, a batch that contains no checks above $1,000 can be approved by Morgan 
Evans alone.  

Sample Relaxed settings where checks are approved at each level by a single, 
appropriate level approver 

 

Clarification: With the above set up: 

• Morgan Evans will only see – and can only approve – checks up to and including $1,000 
CAD (functional currency).  

• Samantha Long will only see – and can only approve – checks above $1,000 and up to 
and including $10,000.  

• Frederic Winkler will only see checks above $10,000.  

In other words, a batch that contains all checks over $10,000 will only be seen and 
approved by Frederic Winkler.  

An auditor may view this as a control deficiency and suggest that either the “All checks must 
be approved at all levels” workflow be used or that a compensating control be put in place.  

The approval activity for a batch is available from the Sage 300 Extended Payment Batch 
program, both during and after the workflow is complete. 

Sample Simplified settings where any three users can approve checks in any order 

 

Step 8 – Choose Check Approval Workflows and Set Up 
Approvers for Banks – Enterprise Edition Only 

The Enterprise Edition of SOX Check Approval also supports four different approval workflows 
based on the bank selected for a payment batch.  
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Note:   

    •    The levels or number of check approvals required, the check approvers and the  
    excluded payment codes are all per company and per bank. 

    •    The workflows apply only to the banks that you specify on this tab. All payment  
    batches for unspecified banks will use the workflow defined on the Company tab. 

You add the banks to the grid at the top of the form, then select each bank in turn and specify 
the approval workflow for each bank. 

 

Banks that Require Approval – Add each of the banks that require a per bank approval 
workflow to the grid at the top of the page. SOX Check Approval lets you choose a different 
approval workflow for each bank. 

Note:  Client’s bank codes are presumed to be unique across all companies in the 
approval process. For example, if a bank code is XYZ and that code is used in multiple 
companies, it should refer to the same bank. 

Select the workflow for each bank in your company listed in the top grid  
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The workflows for companies and banks work the same way. See Sample Check Approval 
Settings in the previous section for approval workflow examples. 

Remember that batches for banks that are not added to this tab will use the workflow 
defined on the Company tab. 

Add or select the bank that you want to set up, and then select the approval workflow for the 
bank from the following drop-down: 

 

• Strict: All checks must be approved at all levels  
This workflow lets you specify up to three levels of check approvers. Choose this 
workflow when the top level of approval must see all checks in all batches. 

• Basic: Checks above level limits must be approved at higher levels after first 
being approved by lower-level approvers 
Like the Strict workflow, this option lets you specify up to three levels of check 
approvers. Choose this workflow when the top levels of approval only want to see 
checks above specified limits, and those checks must first be approved at lower levels. 

When you choose “Basic”, a set of fields will appear below the check approvers to let 
you specify the approval limit for each lower level in the bank currency. 

• Relaxed: Checks above level limits must be approved at higher levels and not 
seen by lower-level approvers 
Like the Strict workflow, this option lets you specify up to three levels of check 
approvers. Choose this workflow when the top levels of approval only want to see 
checks above specified limits, and those checks are not to be approved at lower levels. 

When you choose “Relaxed”, a set of fields will appear below the check approvers to let 
you specify the approval limit for each lower level in the bank currency. 

• Simplified: Checks must be approved by a number of users 
Choose this workflow when each check requires more than one approver, but there is no 
hierarchy for approvers. 

Select the number of approvers / approval levels  

If you choose the Strict, Basic, or Relaxed workflow, you can have up to 3 levels of 
approval.  

 

If you choose the Simplified workflow, you can require up to 3 check approvers per check.  

 

Select the check approvers at each Level 

Note: Approvers must first be added as Sage 300 users to appear on the Banks tab.  
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You must identify all check approvers at Level-1, level-2 and level-3 if you use the Strict, 
Basic, or Relaxed workflow (and you use 3 levels).  

• You cannot select the same check approvers at multiple levels. If you want multiple 
approvers – in any order – choose the simplified workflow. 

• Approvers will only get email notification to approve a batch if they are approvers for the 
bank assigned to the batch and if they did not already approve it (in a Simplified 
workflow).  

Note also that users cannot be approvers for a batch they submitted unless you select 
the option “A User Can Approve a Batch They Submitted” on the Options tab.  

If you use the Simplified workflow, you must identify all acceptable approvers. Approvers 
can only approve a batch once. 

You will see a warning message if you change the check approval levels: 

 

Warning: This message applies to you if you are already using SOX Check Approval and 
have batches that are currently in the approval process. To avoid issues, you should 
approve all batches that are currently in progress before changing workflows. 

Specify the check limits if using the Basic or Relaxed workflow  

When you choose “Basic” or “Relaxed”, the following set of fields will appear below the 
check approvers to let you specify the approval limit for each lower level. Checks below a 
level limit do not need to be approved at the next level  

 

Note:  Level limits are in the bank currency – not the functional currency. 

When Changing Levels of Approval and Limits:  You can change the Levels of Check 
Approval and the Approval Limits; however, to avoid issues, you should approve all batches 
that are currently in progress before changing workflows. 

Any batches that are in the approval process will still require the original approval levels – 
which means that, if the number of approvers changes from 3 to 2, the unapproved batches 

will still need a third level of approval.  

Sample Check Approval Settings 

See Sample Check Approval Settings in the previous section: Step 7 – Choose Check Approval 
Workflow and Set Up Approvers for Company Workflows. The workflows for companies and 
banks work the same way. 

Also see Using Windows Authentication with Sage 300 users and Check Approval Console sign 
on error messages in Step 7 for more information on adding approvers. 
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Checking Batches on the Data Tab 

The Data tab shows check batches and checks that have been submitted for approval, 
depending on the drop-down choice.  

Batches: 

 

• Select “Check Batches” and click the Load button to view the details of batches waiting 
for approval. 

 

• Double-click a batch entry to view the list of payments. This is the same list that appears 
if you select “Checks” and click the Load button – as shown below – except that it lists 
payments for a single batch. 

 

Note:  If you need to return a batch to Open status and cannot return the batch to the 
submitter using the Check Approval Console, an Administrator can return a batch to Open 
status by removing the batch entry from the Approval database. 

• Open the Check Approval Setup program on the Sage 300 desktop. 

• Go to the Data tab, select Check Batches, and click the Load button.  

• Select the batch that you want to return to Open status, and press the Delete key. 

• Click the Yes button to confirm the procedure. 

Checks: 

 

• Select “Checks” and click the Load button to view the list of payments waiting for 
approval. 

• Double-click a payment to see the payment application details.  
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Note:  A Document button appears at the bottom of the screen for applied payments if 
Altec DocLink is installed on your system. Click the Document button to drill down to 
original A/P documents.  
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Additional Setup Requirements for Orchid 
Document Management Link 

The SOX Check Approval console displays all matching entries set up in Orchid DML. 

Note:  Prior to June 2020, the Check Approval program took the first matching entry for the 
vendor, for payment document, and the document being paid. This meant that the console 
previously displayed 3 sections, but now it can display as many as the user wants to set up. 

Check Approval Console showing Orchid DML popup with 3 document sections 

 

Check Approval Console showing Orchid DML popup with 4 document segments 

 

Entering Configuration Details in Orchid’s Setup Program 

Document management integration with Orchid Document Management Link is controlled by 
the SOX Check Approval activation code. But you also need to enter configuration details for 
each document set that you want to display using Orchid’s Setup program. 
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Orchid Setup Options 

 

• SOX Check Approval Console displays document sections according to the display 
order specified in I/M Options. Entries with a blank or 0 appear at the top. 

Note the following points: 

• Previously, the Check Approval console looked only at entries with RotoID WW2000. As 
of June 2020, this is no longer the case. The program will also consider entries with a 
blank roto ID, as Orchid will match these to any screen with the correct field labels. 

• Newer versions of Orchid DML allow you to specify a heading for each entry that will be 
displayed by SOX Check Approval console. 

• Newer versions of Orchid also have an option to specify that you want subdirectories of 
the folders displayed. SOX Check Approval will respect this setting if possible. 

Orchid Setup Details screen 

 

IMPORTANT:  You can set up the entries in Document Management Link for all users or for 
specific users.  
 
If you set them up for specific users, you must be sure to create entries for the users that 

will be using the approval console. 
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SOX Check Approval Security  

SOX Check Approval uses Sage 300 security groups to prevent unauthorized users from 
changing program settings, printing payment audit reports and submitting payment batches for 
approval.  

Security groups and user authorizations are all defined through Administrative Services – just 
like core Sage 300 modules. 

To create security groups for SOX Check Approval: 

• Choose Security Groups from the Administrative Services folder. 

• Select SOX Check Approval from the Application dropdown. 

 

• Enter a group ID and description. 

• Select the security tasks you want for each group. 

Once you create security groups, you can assign them to individual users. 

Note:  Access to the Approval Console is determined by settings in the Check Approval 
Setup program – not by security groups. 

 • Only assigned users can log into the standard Check Approval Console that’s  
 launched from the Windows Start List. 

 • Any user can open the Web Screens Approval Console; however, only assigned  
 users will be able to review and approve batches that were submitted for approval. 

Batch Creation, Editing, and Submitting a Batch for Approval 

Users require Payment Batch Entry security rights in Accounts Payable in order to create, edit 
and submit payment batches for approval. 

Setup Maintenance security task 

Users must be granted Setup Maintenance security rights to be able to view or edit any SOX 
Check Approval settings. 

Audit Report security task 

Users must be granted the Audit Report security rights as well as be able to view AP payment 
batches (Payment Batch Inquiry, Payment Batch Entry, or Payment Batch Posting) in order for 
the Audit Report to show up on the Sage 300 desktop or on the Web desktop. 
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Rights Required for the Approval Console’s Sage 300 User Account  

You specify the Sage 300 user account that will be used by the Check Approval Console to sign 
on to Sage 300 on the System tab of the Check Approval Setup program. This user account is 
required to connect the Approval Console to Sage 300 and perform the processing operations 
when batches are approved. 

Typically, you will use the ADMIN user ID for Sage 300 sign on – however, if necessary, you 
can use a different Sage 300 User ID that has Payment Batch Entry rights.  

For example: 

• Create a new user called “APPROVE”. 

 

• Create a new security group “APPROVE” with Payment Batch Entry security access. 

 

• Assign User ID “APPROVE” to the “APPROVE” security group. 

 

• Specify the APPROVE user ID on the System tab of the Check Approval Setup program. 
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Installing Sage 300 Web Screen Customizations 

Follow these instructions to install the Web Screen customization package for SOX Check 
Approval. The customization package adds a button to the A/P Batch Payment list for submitting 
payment batches for approval and for checking the approval status of submitted batches. 

To install Web Screen customization packages for Sage 300cloud: 

• Install the version of SOX Check Approval and SOX Check Approval Web Screens that 
matches your version of Sage 300. (See SOX Check Approval installation files.) 

• Copy the customization zip file for SOX Check Approval Web Screens (for example, 
TaiRox.SCA.Customization_2023_0.zip) to a convenient location. You will need to find it 
easily to import it. 

Make sure that you copy the customization files that match your version of Sage 300. 

• Open your browser and browse to <Sageserver\instance>Sage300/admin to open the 
Sage 300 admin portal. 

 

• Select the System database, and sign in with an Admin password. 

On the Import Customizations screen: 

• Click the Browse button and find the Customization zip file 
(TaiRox.SCA.Customization_2023_0.zip). 

 

To Delete a prior customization first, select the prior customization from the Package 
ID dropdown, and click the Delete button. 
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• Double-click the zip file to select it, and click Import button.) 

 

• Click the Assign button at the bottom of the Import screen, select the companies that use 
SOX Check Approval, and click OK. 

 

• Sign out of Sage 300. 

• Clear your browser’s cache of temporary Internet files and exit the browser. 

• Open a Command prompt and enter iisreset to restart iis. 

 

• Verify the installation be signing in to the Sage 300 portal and opening the AP Payment 
Batch List program. 

 



Check Approval FAQ  Installation and Upgrade Issues 

SOX Check Approval for Sage 300 29 Setup Guide 

Check Approval FAQ 

Read user guides for SOX Check Approval carefully in addition to reviewing this FAQ. 

Note that SOX Check Approval is described in several documents, each one intended for a 
different kind of user.  

• SOX Extended Payment Batch List User Guide is for users of Sage 300 who prepare 
payment batches and submit them for approval using the Sage 300 Windows desktop. 

• SOX Check Approval Console User Guide is for key users who will perform a 1, 2 or 
3-step approval using the Windows-based approval console. These users may not be 
familiar with Sage 300. 

• SOX Check Approval Web Screens User Guide is for users who will approve 
payments or who will submit A/P payment batches for approval using the browser-based 
Sage 300cloud interface. 

• SOX Check Approval Audit Report User Guide is for users who oversee the A/P 
check process and want to print reports from the Sage 300 Windows desktop. The report 
provides an audit trail for the approval of Sage 300 checks. 

• SOX Check Approval Setup Guide is a document written for system administrators 
who will install the software, set up databases, and configure the solution.  

• SOX Check Approval Update Guide provides important information for system 
administrators who are updating an installation from a prior version of SOX Check 
Approval. 

Installation and Upgrade Issues  

Q: Where can I get release notes for SOX Check Approval, and what will they tell 
me? 

A: Click the Release Notes link in the upper left-hand corner of the SOX Check Approval 
product page on the TaiRox web site. 

Among other things, the Release Notes will tell you about recent fixes and provide program 
compatibility information. For example: 

Build 2022-09-19 

 - Support is added for Sage 300 2023. 

 

Build 2022-03-24 

 - Support for the Advanced Complex Passwords feature added in Sage 300 

2022 PU2. 

 - Fixes an issue in the Basic workflow that under certain conditions 

caused an approval level to be skipped. 

 - Setup options have been grouped to separate system-wide settings from 

company-specific settings. 

 

Build 2021-10-13 

 - A new workflow, Basic, is added.  

http://tairox.com/downloads/checkapproval/SOXCheckApprovalReleaseNotes.txt
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Q: I just installed Check Approval, but the default Sage icons are all still there. 
What happened? 

A: If you just installed the new version of SOX Check Approval 2018-202n, you will not see a 
change in the A/P icons. The new version of SOX Check Approval subclasses the A/P 
Payment Batch List and Payment Entry programs to add functionality that forces batches to 
be submitted for approval before you can print checks and post payments. 

As part of the upgrade procedure to SOX Check Approval 2018-202n, you must Uninstall 
the Desktop Menu control from all workstations that have a full install of Sage 300.  

A2: If you are running “the classic” version of SOX Check Approval (for Sage 300 
versions 2012-2017), you must install the Check Approval program and install the desktop 
menu control on each computer where Sage 300 is physically installed. The Desktop Menu 
control must be installed on all workstations that have a full install of Sage 300.  

General Installation Notes: 
Most SOX Check Approval users have one or more RDP servers and use workstation setup. 
Make sure that you install the SOX Check Approval program and install the desktop menu 
control on all RDP servers. 

It may help to sketch out your Sage 300 and Check Approval installation. 

• You require one (and only one) approval database for Check Approval. 

• You need to activate Check Approval for each company using Check Approval. 

• You need to install the Desktop Control on each computer that has a full install of Sage 
300. 

o If Check Approval 2012-2017 is active for the company, installation adds the new 
Extended Payment Batch List function to the A/P Transactions menu and removes 
the Sage 300 Payment Batch List and Payment Entry functions. 

Q: Why did the Extended Payment Batch List icon disappear from the A/P 
Transaction folder? 

A: Note that after January 2021, versions of the program that work with Sage 300 2018-202n 
do not change the icons in the A/P Transaction folder. 

 If you are using a version of SOX Check Approval that was released before January 2021 – 
or if you installed the version for Sage 300 2012-2017, note the following. 

Did you just update Sage 300?  

For older versions of SOX Check Approval, you must Install Desktop Menu Control on the 
Check Approval Setup Installation tab when you install or update Sage 300 so certain Check 
Batch operations can be blocked and the correct icons appear on the Accounts Payable 
folder on the Sage 300 desktop. 

• Click the Uninstall Desktop Menu Control button before installing any Sage 300 
updates. Then click the Install button after the Sage 300 update is complete. 
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Q: Why don’t I see everyone that I want to add as check approvers on the Users 
tab? 

A: All check approvers must first be added as Sage 300 users in order to appear on the Users 
tab. In addition, all submitters and users must have an email address in the Email 1 field of 
their Sage 300 user profile in order to be sent email notifications. 

Q: I just updated SOX Check Approval and got a message that the database  
needs to be “created or converted.” What’s wrong? 

Note: These messages can appear when you open the SOX Check Approval Console 
program or when you open the A/P Payment Batch program or the SOX Check Approval 
Audit Report 

             

A: These messages appear if you updated SOX Check Approval and you also need to update 
the Check Approval database because of program changes.  

For example, the April 2025 update required you to update the Check Approval program, 
and then update the Check Approval database because database was changed in April 
2025 to add the check batch approval date. 

 To update the Check Approval database: 

• Sign on to Sage 300 as an administrator and open SOX Check Approval Setup. 

• Select the Database tab. 

• Click the Convert button. 

 

The program will display the following message: 

 

If you have backed up your database, click Yes to convert the data. The following 
message will appear: 
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Q: I moved all Sage SQL databases and the Approval database to a new SQL 
Server and installed the latest versions of Sage modules and Cheque Approval 
Desktop and Console on a new server.  

All Sage modules appear properly, but I don’t see SOX Check Approval on the 
Sage Desktop, and I get the following message when opening the Check 
Approval Console. What’s the problem? 

 

A: If Check Approval Setup does not show up on the Sage 300 Desktop, you need to install the 
C/C++ runtime that is shipped with the SOX Check Approval installation files -- 
vcredist_2013_x86.exe. 

As noted in the readme file “READ-WHY-NEEDED-vcredist_2013_x86.txt”, the C/C++ 
runtime required by SOX Check Approval may not be present on newer versions of 
Windows such as Windows 10. 

 

 You also need to copy the TaiRoxChqApproval.ini file from the old server’s Sage 300 
SharedData Folder to the Sage 300 SharedData Folder on the new server.  

 

And you will need to update the Sage 300 User in Check Approval Setup – typically, the 
ADMIN user –that’s used to authenticate check approvers when they log in to the Check 
Approval Console. 



Check Approval FAQ  Issues with Email Setup 

SOX Check Approval for Sage 300 33 Setup Guide 

Issues with Email Setup 

Q: I can successfully send a test email to my Gmail account from the SOX Check 
Approval Setup program, but I get an email error message when I submit A/P 
batches for approval, and email notification is not sent to approvers. 

A: Check the port number for the Email Server on the Email Notification tab in SOX Check 
Approval setup.  

If it’s set to port 465 in Setup, the test will work properly, but email notifications will not be 
sent from the Web Screens. Change the email port to 587, test the settings, then check that 
it works with the Web screens. 

All approvers must have an email address in the Email 1 field of their Sage 300 user profile. 

Also check that your Gmail account is configured to allow access for less secure apps. 

Q: How can I test email for the Web Check Approval Console. It doesn’t have a 
choice to send a test email. 

A: You can test the Web Check Approval Console email by installing the Classic Check 
Approval Console on the web server, and then use the Classic Check Approval Console to 
test email. 

Q: How do I list multiple recipients for distribution lists or for sending test emails 
from the Email Notifications tab? 

A: Use commas or semicolons to separate email addresses if you need to enter more than 1.  

 Note that newer versions of SOX Check Approval (as of December 2022) do not use 
distribution lists. The program uses the Email 1 email addresses stored in Sage 300 User 
profiles.  

Q: I am trying to set up email notification in TaiRox Cheque Approval, but I am 
receiving the following error. I have checked many times, and the username 
and password are correct. What’s wrong? 

 

A. Confirm that the username and password are correct, and review the log file. 
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 For example, the following log extract suggests that 2-factor authentication is in place (and 
the second factor has not been entered on the device where you are running SOX Check 
Approval). If 2-factor authentication is on, you might read this article: 

https://support.microsoft.com/en-us/account-billing/turning-two-step-verification-on-or-
off-for-your-microsoft-account-b1a56fc2-caf3-a5a1-f7e3-4309e99987ca 

 readSmtpResponse: 

     SmtpCmdResp: 535 5.7.3 Authentication unsuccessful  

   [MWHPR21CA0063.namprd21.prod.outlook.com] 

     (leaveContext) 

 SMTP authentication failed after sending password. 

 office365_tips: 

     Your office365 account might be requiring MFA (multi-factor authentication). 

     Change your office365 account settings to allow single-factor authentication  

    (allow legacy authentication). 

     See https://docs.microsoft.com/en-us/azure/active-directory/conditional- 

    access/block-legacy-authentication 

     Also, you may need to create an App password. 

Q: How do I turn on email logging and view the log file? 

A: Select the “Enable Email Logging” checkbox on the System tab for SOX Check Approval 
Setup. The logging option creates a technical email log that documents all of the 
handshaking involved in communicating with an SMTP server. This feature helps you 
diagnose setup issues, as well as ones that arise due to email providers’ changes. 

 

You can find the email log file in: 

>Sage300\SharedData\Company\TaiRox SOX Check Approval \Logs 

Issues with A/P Check Batches 

Q: I have AP check batches. Why do I get this message when I submit the 
batches for approval? 

Incorrect Procedure. Payment batch 712 has no payments or checks that need check 
approval. Payment batch 712 does not need to be submitted for check approval. 

A: Review the “Submit These Payment Types for Approval” option on the Options tab (or 
Installation tab in older versions) for SOX Check Approval Setup. Older versions of Check 
Approval only submitted transaction type “Check” for approval. (Check Approval allowed 
other payment types in Oct 2020.)  

Note that payment types are associated with payment codes, which can be assigned cash, 
check, credit card, or other payment types. If you are submitting Check payment types only, 
then Check Approval will not be involved if the type is “Cash” or “Other”. 

https://support.microsoft.com/en-us/account-billing/turning-two-step-verification-on-or-off-for-your-microsoft-account-b1a56fc2-caf3-a5a1-f7e3-4309e99987ca
https://support.microsoft.com/en-us/account-billing/turning-two-step-verification-on-or-off-for-your-microsoft-account-b1a56fc2-caf3-a5a1-f7e3-4309e99987ca
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Also, changing the ‘Payment Type’ in Payment Codes after entering a transaction does not 
affect existing Payment Entries. If you entered a payment that requires approval with the 
wrong payment type, you must delete it, then re-enter it with the correct Payment Type. 

Q: How can I return a batch to Open status that was submitted for approval? 

A: The standard way to return a batch to Open status is to have an approver use the Check 
Approval Console to return it to the submitter. 

If you cannot return the batch to the submitter, an Administrator can return a batch to Open 
status by removing the batch entry from the Approval database. 

• Open the Check Approval Setup program on the Sage 300 desktop. 

• Go to the Data tab, select Check Batches, and click the Load button.  

 

• Select the batch that you want to return to Open status, and press the Delete key. 

• Click the Yes button to confirm the procedure. 

 

Q: We have batch that is “hung up” in the approval process. How can we reset it? 

A: No matter why the batch became stuck, you can follow the instructions in the previous FAQ 
“How can I return a batch to Open status that was submitted for approval?” to return a batch 
to Open status, and then resubmit it. 

A batch can become “stuck” if you change the approval workflow (usually by reducing the 
number of approval levels) after submitting the batch for approval. 

Issues with the Check Approval Console 

Q: Why do I get an Invalid Input or a Signon Failed message when I try to log in to 
the Check Approval Console? 
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A: Invalid Input message can appear if the user ID you entered has not been added to Sage 
300 or if the password you entered is incorrect.  

If this is your first time signing in, check with a system administrator that the User ID has 
been added in Sage, and confirm the password. (You can test the ID by signing on to Sage 
300.) 

A “Signon failed” message can appear if you were assigned a new Sage 300 ID that required 
a password change on the first login.  

If this is your first time signing in, you should sign in to Sage 300 first to ensure your ID 
works properly, and then change your password if requested by Sage. 

Q: How can I change my signon password for the Check Approval Console? 

A: Your Check Approval Console ID and password were assigned in Sage 300.  

Start Sage 300, then click the “Change Password” button when the Open Company signon 
screen appears. 

Q: Why do I get a message about “Integration with document management 
software? 

A: SOX Check Approval integrates with Altec DocLink and Orchid Document Management 
Link, allowing check approvers to drill down to and examine source documents that have 
been paid – mainly invoices. 

When applicable, the Document Number column in the Console includes a button that you 
can click on to launch a document management product to view the original source 
document.  

Q: We submitted a Payment batch which shows Check Creation in Progress 
status. It has been approved in Level 1, but it does not show up in the Check 
approval console for any of the Level 2 approvers. 

Here is our settings screenshot. 

 

A: You have the same approvers for level 1 and 2. If you want the same approvers for each 
level (that is, you want each check approved by 2 people, in any order), you should use the 
Simplified workflow.  

• Simplified: Checks must be approved by a number of users. Choose this workflow when 
each check requires more than one approver, but there is no hierarchy for approvers.  
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If a user approves a batch at level 1 – and the user is also a level 2 approver – the batch will 
be approved at both levels. 

Q: I have a batch with a single payment that is not approved. How can I move the 
batch along so it is no longer in the queue. I get an error when I try to approve 
the batch without approving the entry. 

 

A: Acknowledge the message, choose View > Refresh from the SOX Check Approval 
Console, and then click the Return button. Type the reason for rejecting the payment.  

SOX Check Approval doesn’t create new batches with rejected entries if no entries have 
been approved. 

Issues with Orchid Document Management Link 

Q: Orchid DML works properly in A/P Invoice Entry and when I enter a payment in 
TaiRox Extended Payment Entry. Why don’t the documents appear in the 
Check Approval Console? 

  

A: Check that the user (network user account) running the TaiRox SOX Check Approval 

Console has read access to the network folder with the A/P documents. 

Use a UNC path to the A/P document drive if running the console from a different server 
from where you run Sage 300. 
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Issues with the Audit Report 

Q: How can I generate an Audit Report? 

A: You can generate an audit report by running the Sage 300 Desktop, opening the SOX 
Check Approval folder, and choosing the “Check Approval Audit Report” icon. 

 

Q: The Check Approval Audit report (and the Extended Payment Batch “In 
Progress” popup) show blank approval dates. What’s wrong? 

 A: If you recently updated the SOX Check Approval database and have batches approved from 
before you updated to the April 2025 version, these batches will not show approval dates on 
the Check Approval Console screens or on the Check Approval Audit report. The dates will 
appear only for batches that were approved after SOX Check Approval was updated (i.e. 
after April 2025). 

Issues with Viewing the Web Screen Audit Report 

Q: The menu choice for the Audit Report does not appear on my screen. What’s 
Wrong? 

A In order for the Audit Report to show on the Web desktop, a user must have been granted 
the Audit Report security rights as well as be able to view AP payment batches (Payment 
Batch Inquiry, Payment Batch Entry, or Payment Batch Posting). 

Q: My browser displays the following error message when I generate an Audit 
Report. What’s Wrong? 
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A: The Check Approval Console generates an audit report in PDF format that needs to be 
downloaded to some browsers in order to be viewed 

Some browsers will let you view the PDF directly, but others will not. Follow the instructions 
listed below to download PDFs for Edge and Chrome. You can then open the downloaded 
PDF files. 

PDF download settings in Microsoft Edge 

• Choose Settings from the Edge menu. 

• Select Cookies and Site Permission. 

• Scroll down and select “PDF Documents”. 

• Turn on “Always open PDF files externally. 

 

PDF download settings in Google Chrome 

• Choose Settings from the Edge menu. 

• Select Privacy and security. 

• Scroll down and select “Site Settings”. 

• Scroll down and expand “Additional content settings”. 

• Select “PDF documents”. 

• Turn on “Download PDF files instead of automatically opening them in Chrome”. 

 

Issues with Viewing Approval Dates and Times in the Database 

Q: The Approval Dates and Times in the Approval database are out by several 
hours. What’s Wrong? 

 

A The Dates and Times are stored in UTC (Coordinated Universal Time) and displayed on the 
audit report according to the time zone of the current user. 
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